# TABLE OF CONTENTS

Using this Guide .......................................................... 3  
Registering to apply for a Full-time Transnet Bursary ............................................ 3  
Online Application for a Full-Time Transnet Bursary ............................................. 8  
Registering as an Applicant at Transnet ................................................................ 13  
How to Register Online ......................................................................................... 13  
Tips for Registered Users ..................................................................................... 16  
Logging on to the Talent Warehouse .................................................................. 16  
Changing a Password ......................................................................................... 18  
Requesting an alternative password: (You forgot your Password) .......................... 19  
Uploading Documents to your Profile .................................................................. 20  
Creating a Profile (Electronic Résumé) ................................................................. 22  
Step one: Candidate Profile Creation using Resume Parsing ............................... 23  
Step two: Personal Data ....................................................................................... 23  
Step three: Education and Training ..................................................................... 24  
Step four: Work Experience ................................................................................... 25  
Step five: Qualifications ....................................................................................... 26  
Step six: Preferences ............................................................................................. 26  
Step seven: Attachments ....................................................................................... 27  
Step eight: Overview and Release ......................................................................... 28  
Browsing/Searching for Vacant Positions .............................................................. 29  
Online Application for a Vacancy ................................................................ .... 32  
Deleting/Withdrawing an Application .................................................................. 37  
Online Display of Status of Applicant Information ............................................. 39  
Telephonic Status Follow-up on Application Progress ....................................... 41  
Maintaining Personal Settings ............................................................................. 42  
Changing Username ............................................................................................ 44  
Recommendation of Job Posting (Tell-a-Friend) .................................................. 45  
Notification of Relevant Employment Opportunities ......................................... 48
Using this Guide
Please note that this User Guide will assist external applicants to:

- Apply for Vacant positions at Transnet,
- Apply for a full time Transnet Bursary, or
- Update/Maintain a Personal Profile.

Kindly therefore ensure your information is correctly captured/updated on our system according to the relevant requirements.

Copyright - No parts of this guide may be reproduced or transmitted in any form without the prior written consent of Transnet SOC Ltd.

Registering to apply for a Full-time Transnet Bursary
We can through our bursary scheme assist you to make your dreams come true.

Full-time bursaries are awarded annually according to the employment needs of the Organisation. All our full-time students are viewed as potential employees – depending on the vacancies being available after successfully completing their qualifications.

Students are permitted to study at a South African University of their own choice who offers the appropriate fields of study and the bursary value covers tuition fees, accommodation and meals, book allowances and experiential training.
When applying for a full time Transnet Bursary, open the Transnet SOC Ltd. website namely www.Transnet.net and Transnet home page will be displayed.

Proceed to access the Career's website by clicking on the “Careers” link on the home page to display the careers page.
On the Careers screen, select the “Registration” option and the “Logon” screen will be displayed.

Click on “Register here” under the Logon heading and the Registration page will be displayed.
Please complete the Registration Form making sure to complete all the required fields, especially those fields marked with an asterisk* as they are mandatory and necessary for the organisation to identify you and contact you appropriately.

Once you have registered, use your username and password to access the site in future. Please note the email address you enter must be unique to you to ensure we can maintain contact with you.

**Transnet Password Rules:**
- Must be at least 8 characters long
- Must contains a Capital (A – Z)
- Must contains a Number (0 – 9)
- Must contains a Special character (!@#$%^&*()><?)

Type the email address and the repeat email address in the fields provided.

Read and check the Privacy Statement which explains how Transnet will protect you and use the personal data you provided. Please note that Registration is not possible without reading and accepting this privacy statement.
Once you have clicked the register tab, the system will automatically send an email to you containing a link to the website including your Username to log onto the system – copy of which is reflected below.

You have now successfully registered with Transnet.
Online Application for a Full-Time Transnet Bursary
Logon to the Transnet Careers website using the logon credentials created.

The “My Profile” page is displayed.
Click on the “Employment Opportunities” tab to activate the job search window.

Under the heading “Search Criteria for Employment Opportunities” scroll down to “Contract Type” and select “Bursar” in the drop-down screen.

Click the “Start” tab to continue and the search results screen will be displayed.
Click on the Bursar position to apply for a full time Transnet Bursary and the Bursar application screen will be displayed.

Click on the “Apply” tab and the Application Wizard screen will be displayed.

Since the personal information you have already entered is still available, choose “Continue” to view your résumé or to add additional information.
Click on the “Add” tab and the “Add Education” screen will be displayed.

<table>
<thead>
<tr>
<th>Subject</th>
<th>Level</th>
<th>Achievement Level</th>
<th>Percentage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grade</td>
<td>High Grade</td>
<td>7 Outstanding Achievement</td>
<td>90%</td>
</tr>
<tr>
<td>Applied Statistics</td>
<td>High Grade</td>
<td>6 Substantial Achievement</td>
<td>70%</td>
</tr>
<tr>
<td>Business Economics</td>
<td>High Grade</td>
<td>6 Substantial Achievement</td>
<td>70%</td>
</tr>
</tbody>
</table>

Complete all the fields required especially those relating to your past academic school performance by completing the fields Subject, Level, Achievement Level and Percentage fields respectively - an example is depicted below for ease of reference.
Select and click on the “OK” tab and the Application Wizard screen is displayed indicating that your application for a bursary has been added for viewing and consideration by Transnet.

Click on the “Close” tab and a “Warning” screen will be displayed where after you are required to click on the “Yes” tab to process your application.

The Transnet Bursary Department, after the screening of all bursar applications received will invite all successful applicants based on their academic performance on secondary or tertiary level will them to and structured interview. These interviews will be conducted in the major centres within South Africa, namely Johannesburg, Bloemfontein, Cape Town and Durban.

The final selection and awarding of bursaries will be subject to a Formal Interview, Satisfactory academic results and Medical fitness.
Registering as an Applicant at Transnet

Once you have registered as an Applicant with Transnet, you will be required to create a Username and Password and submit the request online, where after you will receive a confirmation email informing you where to access the Transnet e-Recruiting System.

Please note that the only browser recommended is Microsoft Internet Explorer version 8.0 or higher. If different browsers or any other versions are used you will not be able to access the system.

To prevent illegal access to your personal profile, please ensure you log-off before leaving the system especially if you are using a computer in the public domain.

Please always make sure you deactivate the pop-up blocker on the computer during this application to avoid being inhibited to display information, since most screens are opened and displayed in separate windows.

How to Register Online

To apply for a vacant position at Transnet, you first need to create and register a profile online. Once registered, you will be given access to the personal career pages website of Transnet.

To do so, open the Transnet SOC Ltd. Career’s website by clicking on the “Careers” link on the home page namely www.Transnet.net and the Careers Page will be displayed.

Click on the “Careers” tab, select “Registration” on the drop-down table and the “Logon” screen will be displayed.
Click on the “Register here” tab and the Registration page will be displayed. Always use your username and password to access the site.

Please complete the Registration Form making sure to complete all the required fields, especially those fields marked with an asterisk* as they are mandatory and necessary for the organisation to identify you and contact you appropriately.

**Transnet Password Rules:**
- Must be at least 8 characters long
- Must contains a Capital (A – Z)
- Must contains a Number (0 – 9)
- Must contains a Special character (!@#$%^&*()?><)

Type the email address and the repeat email address in the fields provided. Please note the email address you enter must be unique to you to ensure we can maintain contact with you.
Read and check the Privacy Statement which explains how Transnet will protect you and use the personal data you provided. Please note that Registration is not possible without reading and accepting this privacy statement.

Once you have clicked the register tab, the system will automatically send an email containing a link to the website including your Username to log onto the system in future.
Now that you are registered, click on the link provided to login to the system entering your Username and Password in the relevant fields provided. This will enable you to create your personal profile and apply for any of the vacant positions advertised at Transnet. You will also have the ability to track your application progress.

**Tips for Registered Users**

*Logging on to the Talent Warehouse*

Once you have registered on our careers website, you need not register again but login using your username and password you have provided. To do so, click on the Transnet Careers website.
The “Careers Page” is displayed.

Click on the login tab to access the careers pages log on screen.

Enter your username and password and click the logon tab.

The applicant Cockpit is opened. If a pop-up messages appears warning you e.g. that you have not yet released your profile, you need to click on “Release Profile” should you wish to do so, which will ensure that the Recruitment Specialist can access your profile.
Release application or profile.

**Changing a Password**

If you wish to change your password, click on the login tab to access the login screen.

Enter your username and password

Click on the “Change Password” link
Enter your current password and new password. Repeat your new password.

Choose the “Change” button.

The system checks your new password and saves it. From here on, only use your new password. Please note that you can change your password only once per day.

**Requesting an alternative password: (You forgot your Password)**

If you have forgotten your password, click on the “login” tab to access the logon screen

The login screen is displayed

Click the on the “Password Forgotten” link

The forgotten password screen is displayed
Enter your username and email address. Click on the “Request Password” link. The system checks whether the username and email address is already registered and then sends an alternative password to the email address entered in your personal data.

Type in the alternative password (the temporary one sent in the email to you) to gain access to your personal career pages.

For security reasons, we suggest you should change the alternative password provided immediately once you have successfully logged on to the system.

**Uploading Documents to your Profile**

The success of uploading your document in the e-Recruiting system begins with the document you create in Microsoft Word.

We require uploading a Microsoft Word document, so the document can convert properly into both PDF and HTML versions to allow for viewing by the Organisation.

Here are just a few guidelines to make that process go smoothly.

i. Use Microsoft Word Version 5.0 (or higher) or save to Rich Text Format for best results.

ii. Use only original Microsoft Word files. If your document has been cut and pasted into MS Word from Claris or WordPerfect, you will have a problem uploading. Use Microsoft Word Version 5.0 or higher for best results.

iii. Documents typically uploaded are résumé, cover letter, and writing sample.

iv. We do not encourage uploading transcripts because they are more complex documents that can cause problems when uploading. If it is necessary to upload a transcript, you may need to copy and paste into Notepad and then copy back into a new Word document to strip the document of any troublesome coding. Save the document under a new name and try to upload again. Also, remove any web links that may be listed on your transcript. Make sure you are uploading your transcript as type “Other Documents”, rather than “Résumé” or “Cover Letters”.

v. Your résumé should be one page unless you are a graduate student with a CV or an alumnus with accumulated work experience.

vi. Create a document of maximum file size 500KB (512,000 bytes). As a benchmark, a 500KB document is approximately 20-22 pages long, using 12-point font and double-spacing. To check the file size of your document, open your document in Microsoft Word, click File Properties to display the Properties box, and then click the General tab. Check the size of the document to ensure that it is less than 500KB.

vii. Use a common font, not one with an unusual typeface. Some examples of common fonts are Times New Roman or Arial.
viii. A minimum of 12 point font is preferred. Anything below that is difficult to read. Sometimes font size can create problems. If you get an error when uploading, you might want to try to change your whole document to 10, 11, 12 point to see what looks best and works successfully.

ix. The upload process will process bullets, bold face, underscore and italics. If you get dollar signs in place of bullets, copy and paste your document into Notepad and then back into a new Word document and save again. This will strip the document of any coding that may be causing uploading errors.

x. Indents should be predetermined. Do not use the spacebar or multiple tabs for spacing.

xi. Do not use password protected files, macros, frames, or tables. Also, be sure your document isn’t set to track changes under the Tools menu. This will cause an error when uploading.

xii. Do not use headers or footers.

xiii. Do not use pagination (adding page numbers).

xiv. Do not set excessive page breaks. Do USE your “enter” key to create a more natural break for formatting and to avoid a page break leaving a hanging word or sentence on the next page.

xv. Do not force your margins. A minimum margin of one-half or three quarters of an inch is recommended.

xvi. If you continue to receive an error or have trouble uploading successfully, copy your document and paste into a new Word document. Save the document with a new name and try uploading again. This strips the document of any unnecessary coding or text that may cause problems when uploading.
Creating a Profile (Electronic Résumé)

To be able to apply for a vacancy online, you need to first create an electronic résumé complete with the necessary supporting documentation. An electronic guide has been designed to enable you to create and submit your application in seven (7) easy steps:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resume Parsing</td>
<td>This functionality will allow you to download your CV and the information contained will be mapped to the data fields available and where possible these data fields will be updated. The CV will be saved as an attachment to your applicant profile. You have to verify the data updated and correct / replace / complete any data not updated correctly.</td>
</tr>
<tr>
<td>Personal Data</td>
<td>This page allows you to:</td>
</tr>
<tr>
<td></td>
<td>• Add your address and contact information.</td>
</tr>
<tr>
<td></td>
<td>• Add your Identification Number or Passport Number &amp; Work Permit number in the case of non SA Residents.</td>
</tr>
<tr>
<td></td>
<td>• Change or update information where it has changed.</td>
</tr>
<tr>
<td></td>
<td>• You do not need to re-enter data already entered when registering.</td>
</tr>
<tr>
<td>Education/Training</td>
<td>This page allows you to:</td>
</tr>
<tr>
<td></td>
<td>• Add and update your completed courses of education and related training details.</td>
</tr>
<tr>
<td>Work Experience</td>
<td>This page allows you to:</td>
</tr>
<tr>
<td></td>
<td>• Add and update your previous employment work experiences.</td>
</tr>
<tr>
<td>Qualifications</td>
<td>This page allows you to:</td>
</tr>
<tr>
<td></td>
<td>• Enter and/or update your competencies and qualifications and assess their proficiency.</td>
</tr>
<tr>
<td>Preferences</td>
<td>This page allows you to:</td>
</tr>
<tr>
<td></td>
<td>• Tell us what type of job/position you would like, or your expectations of your new working relationships with Transnet.</td>
</tr>
<tr>
<td>Attachments</td>
<td>This page allows you to:</td>
</tr>
<tr>
<td></td>
<td>• To upload relevant attachments to your application such as Transcript’ s, Degree certificate’s and detailed résumé etc.</td>
</tr>
<tr>
<td>Overview and Release</td>
<td>This page allows you to:</td>
</tr>
<tr>
<td></td>
<td>• Review your application and submit/release it to Transnet. Remember, you must read the data privacy statement carefully and accept it if you have not yet already done so, failing which we cannot access your application.</td>
</tr>
</tbody>
</table>
**Step one: Candidate Profile Creation using Resume Parsing**

This functionality will allow you to download your CV and the information contains will be mapped to the data fields available and where possible these data fields will be updated. The CV will be saved as an attachment to your applicant profile. You have to verify the data updated and correct / replace / complete any data not updated correctly.

After completion you will receive a system message requesting you to review your profile and to ensure all data is updated correctly.

**Step two: Personal Data**

Click on the “My Profile” tab if you are not already on the overview page and the “Applicant Profile” will be now be displayed. Complete all the fields as you work your way through all the steps as indicated in the table above to complete the application using the guide to help you. (Remember you can proceed to any step by clicking on the relevant step button if you so wish)
Once you have completed all the steps on the personal data page, click on the “Next Step” tab to continue with the roadmap until complete. Note that all the steps marked with an asterisk “*” are mandatory and have to be completed before navigating away from that specific page.

**Step three: Education and Training**

The “Education and Training” step is now displayed. Click on the “Add” tab to complete this section. A new window opens for you to add the new detail. Click “OK” once all the mandatory fields are completed. Click on “Transfer” to save the information. Continue to add for each new entry required.

Note that you can edit or delete information by clicking the relevant “Edit” or Delete” tab at the bottom of the screen at any time!
Step four: Work Experience

The “Work Experience” step is now displayed. If you have any work experience, it needs to be captured here. Click the “Add” tab to add each job you have had individually. Remember to click on the “OK” tab in the new window to save the information you have entered.
Complete all the relevant fields and click on “Next Step” to proceed to the next roadmap step.

Step five: Qualifications

The “Qualifications” step is now displayed. This is where you enter your competencies and qualifications and rate (assess) the proficiency of each qualification added to your profile. For example, if you select a Drivers Licence code EB from the list provided, you need to select whether you are able to drive a vehicle or if you select a specific Degree, you need to select the level of proficiency such as not rated, partially rated or complete etc.

Click on the “Add” tab to enter each of your qualifications. The scroll bar and tab buttons will assist you in finding relevant qualifications. Remember to always click on the “Proficiency” drop-down tab to inform us whether the qualification has been completed or not.

Click on “OK” to save any new or changed information before clicking “Next Step” to continue to the next roadmap step.

Step six: Preferences

The “Preferences” step is now displayed. This is where you indicate the type of job, expectations and interests of the new job location etc. This means you can select the type of job you would like to have by selecting the following:

- Type of Industry – selecting one of the Industries from the drop-down table.
- Functional Area – selecting e.g. Administration, Legal Services or Operations etc.
- Hierarchical Level – selecting e.g. Executive, Professional or Technical etc. and,
• Desired Work Location – your preferred work location.

Click on the “Add” tab and enter the individual answers by selecting the appropriate responses in the drop-down screens. Complete all the relevant information and click on the “Next Step” tab to continue to the next roadmap step.

**Step seven: Attachments**

The “Attachments” step is now displayed. This is where your application is completed by uploading any supporting documentation such as copies of your identification document and qualifications etc. Click on the “Add” tab and browse your computer’s hard drive or flash drive to identify the appropriate documents.

Please note that only certain file-type formats will be accepted i.e. only documents with the following extensions: doc; xls; pdf; jpg; rtf and gif. No Power Point (ppt) documents will be accepted. The document size may not exceed 3 megabytes per document and a maximum of 20 attachments will be permitted.

Once you have found the documents on your hard drive or flash disk drive, “Open” and enter the title of the document into the “document title” field and select the relevant values from the drop down options as necessary. Note that each document needs to be uploaded.
separately. Click on the “Transfer” tab to save your attachments and complete your application.

Click on the “Next Step” tab to continue to the next roadmap step.

**Step eight: Overview and Release**

The “Overview and Release” tab is now displayed.

If you wish your profile details to be searchable, you are required to release your profile to enable the Transnet Recruitment Team to view your detail when searching the talent warehouse.

Not releasing your profile i.e. keeping it in a “locked state” means that it will not be visible to the Transnet Recruitment Team for job matching purposes, however, your profile will be visible to Transnet to access your job application.

Review your information and once you are happy with what was captured, click on the “Complete” tab to complete the process. A confirmation message and window will be displayed that shows your applicant profile was locked successfully.
Note that if you do not complete this step, your profile will remain in “draft” format when you view it in “My Applications” and will not be accessible to Transnet Recruitment Specialists to view and process your application appropriately.

**Browsing/Searching for Vacant Positions**
Should you wish to search for vacancies at Transnet, click on the “Careers” link on the Transnet Website (www.Transnet.net) and the Careers page will be displayed.

Click on the “Employment Opportunities” tab and the “Job Search” page will be displayed.
Click on “Start” to commence the search for all jobs posted within Transnet without filtering criteria. Alternatively, use the appropriate filters i.e. Functional Area, Contract Type and Hierarchical Level etc. to refine your job search. The Job Search Hit-List results will be displayed.

Click on the “Job Posting” hyperlink that you are interested in for further details pertaining to the job or jobs searched for. Note that this page can always be printed by clicking on the “Print Preview”, “File”, “Print” tab and then Click on the “Close” tab.
Should you wish to refine or extend the search criteria, click “Return” and continue as above?
Online Application for a Vacancy
Click on the “Employment Opportunities” tab to activate the job search window

Click the “Start” tab to continue. The Employment Opportunities search criteria window is now displayed.

Click on the relevant job posting link to display it. The “Overview Job Posting” window is now displayed.
Click “Apply” and the Application Wizard window will be displayed.

Click on the “Display Job Posting” link to display the detail of the position advertised.

Click on “Continue” tab to start the application wizard for the relevant window to be displayed.
Should you wish to update your application or to upload an updated CV before you submit it for the position to be applied for, do so by working your way through the relevant steps of the wizard until all the required steps have been completed?

Where you are required to complete a questionnaire, click on the “Questionnaire” tab and the Questionnaire screen will be displayed.

Read through the questions and answer those relevant to the job you are applying for. You can click on the “Reset” tab at any time to clear the questionnaire if you wish to re-enter responses. Note that an asterisk “*” denotes a mandatory question which must be completed, failing which you will not be able to submit your application.

If you wish to submit your application at a later stage, or if you require additional information to be added before submission, just click on the “Close” tab. The system will give you a warning and you can click on “Yes” to proceed or “No” to cancel. Your application will then be saved and can be accessed again later.

The “Complete Application” step is now displayed.
Click the “Privacy Statement” tab to display and familiarise yourself with the Transnet Privacy Statement. The approval for the profile to be released “Check Box” button is selected as the default.

When you are satisfied that your application has been correctly completed, click on the “Send Application Now” tab to complete the transaction. Note that if you do not select the check box for releasing the profile, the system will give you a warning message.

Proceed by clicking on the “OK” tab or on the “Cancel” tab to change any information. However, once you have clicked on the “OK” tab, the “Application Wizard” window will be displayed.

A message will be displayed confirming that your application has been successfully sent.
Click on the “Close” tab to close the window and return to the “Job Posting” screen again.

Please note that if you do not see the “Application Wizard” screen, this means that your application was not correctly completed and will not be available for the Transnet Recruitment Specialists to access for processing.

When your application was successfully processed, you will receive a confirmation of receipt to your email address.

Ms Antony Other
1 Main Road
CAPE TOWN
0001
SOUTH AFRICA

Date 08 February 2013
Dear Ms Antony Other,

RE: Application

We appreciate your interest in Transnet SOC Ltd, your application for the position, has been received.

Your unique application number is 500081511.

To enquire about your application status please contact the Transnet Employee Interaction Centre (EIC) on 011 7741502.

Thank you for your interest shown in our company.

Yours sincerely,

Recruitment Team
TransnetSOC Ltd
The “Job Search” window is now displayed and if you have applied for more than one job, you can click on the “My Applications” tab and the window displayed will reflect the application status for each job you have applied for.

Deleting/Withdrawing an Application
Once logged into the system in the Applicant Cockpit, the “My Profile” overview screen is displayed.

Click on the “Employment Opportunities” tab and the “Job Search” tab will be displayed.

Click on the “My Applications” link and the window will be displayed.

Click to select the “Job Posting” selection box button to highlight the application you would like to delete or withdraw.
Click on the “Delete/Withdraw” tab to withdraw the application and the “Withdraw Application” dialog box will be displayed.

![Image of the Delete Application dialog box]

Note, if you selected a job posting with the status “Draft”, the system will allow you to delete the complete application after you have clicked “Yes” in the dialog box. Note one of the draft applications has been removed.

Where your application was already submitted with the status reflecting “In Process”, the system automatically opens the “Withdraw Application” screen where after you must click the “Yes” tab since any submitted application cannot be deleted – only withdrawn.
Click “Yes” to continue and a message confirming that your application has been withdrawn for a selected job will be displayed. You will also receive a notification confirming your application has been withdrawn.

You will note that the status of your application has now been changed to “withdrawn”. Where the status was in “Draft”, the entry will be completely deleted and will not be displayed for viewing on the list.

**Online Display of Status of Applicant Information**

When accessing the “My Applications” link, you can view all your applications you have started to create or have already sent for processing.

To view your applications sent, click on the “My Applications” link in the “Overview” tab.
All The applications you have submitted are displayed.

Highlight the application you wish to display by clicking on the tab next to the application.

Click on the “Continue/Display Application” tab to continue. Depending on the different statuses of your application, different screens will be displayed to continue with your work.

For applications in “Draft” format, the application wizard will appear enabling you to continue working on your existing incomplete job application.

For applications with other statuses such as “In Process”, “To be hired”, “Not selected” or “Withdrawn”, an overview page will appear.
When complete, click on the “Close” tab to close the window.

Please note that one cannot submit an application twice!

**Telephonic Status Follow-up on Application Progress**

Transnet has a facility called the Employee Interaction Centre (EIC) which is an unmanned call centre which is available to external Applicants once they have registered and applied for vacancies online to follow-up on the progress on their specific applications made by using the **unique** Application Reference Number provided.

The EIC Call Centre telephone number is Tel: 011 774 1502.

When you apply for a vacancy, you will receive an email or an SMS with your unique Application Reference Number - e.g. “50081511”.

Once the EIC Call Centre number is dialled, listen carefully and follow the voice prompts and capturing the correct information and unique reference number requested to confirm the status of your application.
Maintaining Personal Settings
Open the “Applicant Profile” window. On the “Overview” window, Click on the “Personal Settings” link and the window will be displayed under the “Applicant Profile”.

![Diagram showing the Applicant Profile window with different tabs and fields for personal settings.](image-url)
Click on the “Date Format” drop-down list tab to select your preferred “Date Format”.

You can also change the “Decimal Notation” should you wish to do so, by clicking on “Decimal Notation” drop-down list.

Note that English will be the official language in which we will correspond with regarding your submitted application.

Once the “Save” tab has been clicked, your information will be saved. The “Personal Settings” window will be displayed again and a message indicating that the data has been successfully updated which will reflect the next time you access the system.
Changing Username
To change your Username, open the “Overview” window.

Click on the “Change Username” tab to open the window under “Applicant Profile”
Enter your new Username in the space provided and click “Save” to save your change. Note that the next time you log onto the system, you must use this new Username failing which it will disallow you to continue.

**Recommendation of Job Posting (Tell-a-Friend)**
Should you wish to inform other people, family or friends whom you believe might be interested in the job advertised in the job search, this process can be followed. The recipient will receive an email containing the link to that relevant job posting which they can display by clicking on the link and then follow due process to apply online if they are interested and meet the requirements of the job in question.
Click on the “Employment Opportunities” tab to display the job search window.

Click on the “Start” tab to continue.
Click on the relevant “Job Posting” link to select it and the Job Posting window will be displayed.

View the Job Posting and decide whether it would be of interest to another party/acquaintance.

If the decision is to inform another party about the employment opportunity, click on the “Tell-a-Friend” tab at the bottom-left of the screen and the “Tell-a-Friend” screen will be displayed in a new window.

Tell a Friend

Use this option to forward interesting employment opportunities to friends and family.
Specify the name and the e-mail address of the recipient. You can also add a personal comment and enter your sender information.
The recipient receives your message by e-mail together with a link to the employment opportunity.

First Name of Recipient: 
Last Name of Recipient: *
E-Mail Address of Recipient: *
Message: 

First Name of Sender: Anthony
Last Name of Sender: 

Copy to My E-Mail Address

Send
Reset
Close
There are two options to tell-a friend, namely;

- You can copy the link of the job posting from the “Tell-a Friend” window to your local email programme, or
- You can open the local email programme automatically by clicking on the corresponding link “Forward Employment Opportunity via Email” on the “Tell-a-Friend” view.

Add any additional information to the email with the link to the employment opportunity and then send the message to the recipient.

Your friend will receive an email with the appropriate link to the relevant job posting which could be used to look at the job posting and apply if interested in the position advertised.

**Notification of Relevant Employment Opportunities**

This process can be used to receive information regularly and automatically regarding employment opportunities that meet the search requirements as defined by you. This could also include criteria for new work relationships defined in your Applicant Profile.

Click on the “Job Alerts” tab to view the job Alerts window.

Select the check Box for receiving emails to allow the system to search and suggest jobs to notify you via your listed email in instances where it finds jobs that might be suitable for you based on your profile.
Click on the “Add” tab to create a new job alert and the Job Search view screen is displayed.

Define your search criteria using Keywords, Functional Area, Contract Type, Hierarchical level etc. and click on the “Save as Job Alert” tab which will open the “Save as Job Alert” window.
Assign a name and define the frequency which the job agent must be run.

Activate the job agent and save your selection by clicking on the “Save” tab.

The system will display the list of all job alerts already defined including the new ones created. Note that the frequency can be changed at any time.

Log off if applicable and the system will confirm that you have successfully logged off.

You were logged off successfully.